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Preface
Purpose
This guide describes how to create and run reports using OpenEdge® Management.

Audience
This manual is designed for users of the OpenEdge Management product. Typical users are 
OpenEdge database administrators and any others responsible for the daily management of an 
OpenEdge database.

Organization
Chapter 1, “Understanding Reports”

Introduces OpenEdge Management report types and OpenEdge Management report 
terminology and contains steps for creating a report instance.

Chapter 2, “Historical Reports”

Describes the trend report templates supplied by OpenEdge Management.

Chapter 3, “Working with Report Instances”

Explains how to schedule reports and view report output. Also contains steps for working 
with scheduled, completed, and running reports.

Chapter 4, “Creating Custom Report Templates”

Describes how to create, edit, copy, delete, import, and export custom report templates.

Chapter 5, “Real-time Reports”

Provides a description of each real-time report.

Chapter 6, “OpenEdge Management Diagnostic Reports”

Provides an overview of the reports used to debug OpenEdge Management. Includes 
information on the OpenEdge Management log file and the work scheduler.
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Using this manual

OpenEdge provides a special purpose programming language for building business 
applications. In the documentation, the formal name for this language is ABL (Advanced 
Business Language). With few exceptions, all keywords of the language appear in all 
UPPERCASE, using a font that is appropriate to the context. All other alphabetic language content 
appears in mixed case.

References to ABL compiler and run-time features

ABL is both a compiled and interpreted language that executes in a run-time engine that the 
documentation refers to as the ABL Virtual Machine (AVM). When documentation refers to 
ABL source code compilation, it specifies ABL or the compiler as the actor that manages 
compile-time features of the language. When documentation refers to run-time behavior in an 
executing ABL program, it specifies the AVM as the actor that manages the specified run-time 
behavior in the program.

For example, these sentences refer to the ABL compiler’s allowance for parameter passing and 
the AVM’s possible response to that parameter passing at run time: “ABL allows you to pass a 
dynamic temp-table handle as a static temp-table parameter of a method. However, if at run time 
the passed dynamic temp-table schema does not match the schema of the static temp-table 
parameter, the AVM raises an error.” The following sentence refers to run-time actions that the 
AVM can perform using a particular ABL feature: “The ABL socket object handle allows the 
AVM to connect with other ABL and non-ABL sessions using TCP/IP sockets.”

References to ABL data types

ABL provides built-in data types, pre-defined class data types, and user-defined class data 
types. References to built-in data types follow these rules:

• Like most other keywords, references to specific built-in data types appear in all 
UPPERCASE, using a font that is appropriate to the context. No uppercase reference ever 
includes or implies any data type other than itself.

• Wherever integer appears, this is a reference to the INTEGER or INT64 data type.

• Wherever decimal appears, this is a reference to the DECIMAL data type.

• Wherever numeric appears, this is a reference to the INTEGER, INT64, or DECIMAL data type.

References to pre-defined class data types appear in mixed case with initial caps, for example, 
Progress.Lang.Object. References to user-defined class data types appear in mixed case, as 
specified for a given application example.
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Typographical conventions

This manual uses the following typographical conventions:

Convention Description

Bold Bold typeface indicates commands or characters the user types, 
provides emphasis, or the names of user interface elements.

Italic Italic typeface indicates the title of a document, or signifies new 
terms.

SMALL, BOLD 
CAPITAL LETTERS 

Small, bold capital letters indicate OpenEdge key functions and 
generic keyboard keys; for example, GET and CTRL.

KEY1+KEY2 A plus sign between key names indicates a simultaneous key 
sequence: you press and hold down the first key while pressing the 
second key. For example, CTRL+X.

KEY1 KEY2 A space between key names indicates a sequential key sequence: 
you press and release the first key, then press another key. For 
example, ESCAPE H.

Syntax:

Fixed width A fixed-width font is used in syntax statements, code examples, 
system output, and filenames.

Fixed-width italics Fixed-width italics indicate variables in syntax statements.

Fixed-width bold Fixed-width bold indicates variables with special emphasis.

UPPERCASE 
fixed width

Uppercase words are ABL keywords. Although these are always 
shown in uppercase, you can type them in either uppercase or 
lowercase in a procedure.

This icon (three arrows) introduces a multi-step procedure.

This icon (one arrow) introduces a single-step procedure.

Period (.) 
or 
colon (:)

All statements except DO, FOR, FUNCTION, PROCEDURE, and REPEAT 
end with a period. DO, FOR, FUNCTION, PROCEDURE, and REPEAT 
statements can end with either a period or a colon.

[ ] Large brackets indicate the items within them are optional.

[ ] Small brackets are part of the ABL.

{ } Large braces indicate the items within them are required. They are 
used to simplify complex syntax diagrams. 

{ } Small braces are part of the ABL. For example, a called external 
procedure must use braces when referencing arguments passed by 
a calling procedure.
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Examples of syntax descriptions

In this example, ACCUM is a keyword, and aggregate and expression are variables:

FOR is one of the statements that can end with either a period or a colon, as in this example:

In this example, STREAM stream, UNLESS-HIDDEN, and NO-ERROR are optional:

In this example, the outer (small) brackets are part of the language, and the inner (large) brackets 
denote an optional item:

A called external procedure must use braces when referencing compile-time arguments passed 
by a calling procedure, as shown in this example:

In this example, EACH, FIRST, and LAST are optional, but you can choose only one of them:

| A vertical bar indicates a choice.

... Ellipses indicate repetition: you can choose one or more of the 
preceding items.

Convention Description

Syntax

ACCUM aggregate expression 

FOR EACH Customer:
DISPLAY Name.

END.

Syntax

DISPLAY [ STREAM stream ] [ UNLESS-HIDDEN ] [ NO-ERROR ]

Syntax

INITIAL [ constant [ , constant ] ]

Syntax

{ &argument-name }

Syntax

PRESELECT [ EACH | FIRST | LAST ] record-phrase
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In this example, you must include two expressions, and optionally you can include more. 
Multiple expressions are separated by commas:

In this example, you must specify MESSAGE and at least one expression or SKIP [ (n) ], and 

any number of additional expression or SKIP [ ( n ) ] is allowed:

In this example, you must specify {include-file, then optionally any number of argument or 
&argument-name = "argument-value", and then terminate with }:

Long syntax descriptions split across lines

Some syntax descriptions are too long to fit on one line. When syntax descriptions are split 
across multiple lines, groups of optional and groups of required items are kept together in the 
required order.

In this example, WITH is followed by six optional items:

Syntax

MAXIMUM ( expression , expression [ , expression ] ... )

Syntax

MESSAGE { expression | SKIP [ ( n ) ] } ...

Syntax

{ include-file 

[ argument | &argument-name = "argument-value" ] ... }

Syntax

WITH [ ACCUM max-length ] [ expression DOWN ] 
[ CENTERED ] [ n COLUMNS ] [ SIDE-LABELS ]
[ STREAM-IO ]
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Complex syntax descriptions with both required and 
optional elements

Some syntax descriptions are too complex to distinguish required and optional elements by 
bracketing only the optional elements. For such syntax, the descriptions include both braces (for 
required elements) and brackets (for optional elements).

In this example, ASSIGN requires either one or more field entries or one record. Options 
available with field or record are grouped with braces and brackets:

OpenEdge messages

OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

• Execution messages inform you of errors encountered while OpenEdge is running a 
procedure; for example, if OpenEdge cannot find a record with a specified index field 
value.

• Compile messages inform you of errors found while OpenEdge is reading and analyzing 
a procedure before running it; for example, if a procedure references a table name that is 
not defined in the database.

• Startup messages inform you of unusual conditions detected while OpenEdge is getting 
ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

• Continues execution, subject to the error-processing actions that you specify or that are 
assumed as part of the procedure. This is the most common action taken after execution 
messages.

• Returns to the Procedure Editor, so you can correct an error in a procedure. This is the 
usual action taken after compiler messages.

• Halts processing of a procedure and returns immediately to the Procedure Editor. This 
does not happen often.

• Terminates the current session.

Syntax

ASSIGN { [ FRAME frame ] { field [ = expression ] }
[ WHEN expression ] } ...

| { record [ EXCEPT field ... ] }
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OpenEdge messages end with a message number in parentheses. In this example, the message 
number is 200:

If you encounter an error that terminates OpenEdge, note the message number before restarting.

Obtaining more information about OpenEdge messages

In Windows platforms, use OpenEdge online help to obtain more information about OpenEdge 
messages. Many OpenEdge tools include the following Help menu options to provide 
information about messages:

• Choose Help→ Recent Messages to display detailed descriptions of the most recent 
OpenEdge message and all other messages returned in the current session.

• Choose Help→ Messages and then type the message number to display a description of a 
specific OpenEdge message.

• In the Procedure Editor, press the HELP key or F1.

On UNIX platforms, use the OpenEdge pro command to start a single-user mode character 
OpenEdge client session and view a brief description of a message by providing its number.

To use the pro command to obtain a message description by message number:

1. Start the Procedure Editor:

2. Press F3 to access the menu bar, then choose Help→ Messages.

3. Type the message number and press ENTER. Details about that message number appear.

4. Press F4 to close the message, press F3 to access the Procedure Editor menu, and choose 
File→ Exit.

** Unknown table name table. (200)

OpenEdge-install-dir/bin/pro
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Understanding Reports

You can create a variety of reports based on data in the OpenEdge® Management Trend 
Database. Each report is based on a report template that is either provided with OpenEdge 
Management or created by you.

This chapter introduces the basics of OpenEdge Management reporting, as described in the 
following sections:

• OpenEdge Management report terminology

• OpenEdge Management report types

• Report instances



Understanding Reports
OpenEdge Management report terminology

It is important to understand OpenEdge Management report terminology so that you can be sure 
you are creating reports based on and containing the kind of data you require.

Remember the following terms as you create OpenEdge Management reports:

• Report History — The history of how a report ran.

• Report Instance — The report entity that you schedule to run in order to produce the 
report result. The report instance identifies specific details that you want reported on; a 
report instance can specify, for example, a particular resource on which to report or a 
period of time that the report covers. You specify these report instance details and also 
schedule when you want the report to run. A report instance is based on a report template.

• Report Log — A file where error messages and debug tracing information for a report is 
written.

• Report Output — The formatted data returned when a report instance is run.

• Report Template — The report template defines the characteristics of the report. When 
you want to create a report instance, you begin by selecting the template on which the 
report is to be based. If you want, you can make changes to some of the properties inherited 
from the template for a particular report instance so that you get the reporting data you 
require; for example, you can specify when you want the report to run and what period of 
time the report should cover. There are template properties that you cannot change in the 
report instance; for example, you cannot change the type and number of resources in the 
report or the location in which the report results are written when the report is run.

In summary, to create reports in OpenEdge Management, you use a report template to create a 
report instance that runs to produce the report output.

OpenEdge Management report types

To open the OpenEdge Management Reports home page, click Reports in the OpenEdge 
Management console menu bar. The OpenEdge Management Reports home page opens, as 
shown in Figure 1–1.

Figure 1–1: OpenEdge Management Reports home page
1–2



OpenEdge Management report types
When you click Reports in the OpenEdge Management console menu bar, the list frame 
updates, showing the three kinds of reports:

• Defined — Reports based on information in the OpenEdge Management Trend Database. 
You create instances of these reports using report templates. See the “Historical report 
descriptions” section on page 2–3 for more information about defined reports.

• Realtime — Reports that show the state of your resources and system at the time the 
reports are run.

• Diagnostic — A report of the OpenEdge Management AdminServer log file, the Work 
Scheduler, and the Task Scheduler.

OpenEdge Management supplies the report templates shown in Figure 1–2 and adds any report 
templates you create to this list.

Figure 1–2: Reports list frame
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Report instances 

Use any existing report template to create a report instance. See the “Creating a custom report 
template” section on page 4–2 for details about creating your own template. You access existing 
report templates from the Create Report page and enter the report instance’s properties on the 
Report Edit page. 

Create Report page

The Create Report page divides reports into five menu groups:

• AppServer™

• Database

• General

• System

• WebSpeed®

Additionally, any menu group you create on the Report Template page also appears on the 
Create Report page. See the “Creating a custom report template” section on page 4–2 for more 
information about creating menu groups and adding new reports to existing menu groups.

Note: OpenEdge Management supports management of the WebSpeed® Transaction Server 
product. Throughout this guide, WebSpeed Transaction Server and WebSpeed are 
used interchangeably.
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Report Edit page

The Report Edit page is divided into three sections. While the content of each section varies 
by report type, certain fields appear on all Report Edit pages:

• The top section:

– Name — The name you assign to your report instance. 

– Description — A brief description of the report instance.

– Output Formats — The format in which you want the report output to appear. See 
the “Viewing report output” section on page 3–3 for output format examples.

– Report Format — The format (Hourly, Daily, Weekly, or Monthly) into which the 
report’s data is arranged.

• The middle section:

– Report on daily information — Indicates that each day covered by the report period 
will have its own column in the output.

– Report Period — Whether the report instance will cover a previous number of 
hours, days, weeks, or months or a specific period of days, weeks, or months. The 
format you select for the report determines the maximum number of periods that the 
report can include, as shown in the following table:

– Time Period within the day to include in the report — Whether the report instance 
should cover a full day (24 hours) or a partial day.

– Display Units — The units in which the data is presented. Options are per second, 
per minute, per hour, per transaction, per record, or as raw data.

This report format . . . Shows a maximum of . . .

Hourly 24 hours

Daily 31 days (7 days if you also select the 
Report on option)

Weekly 52 weeks

Monthly 48 months
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• The bottom section:

– Environment — Any environment variables. Available environment variables 
depend on the type of report you are creating and your environment. For a list of 
environment variables available for your report, run the report with the Generate 
debug log file option on. The debug log file lists all environment variables and, if 
applicable, their values. For more information about viewing environment variables 
in the debug log file, see the entry for Generate debug log file.

If the report’s output will appear in HTML, you may want to set the 
GRAPH1COLUMNS or the fathomResourcesPerGraph variables. See the 
“Graphical output environment variables” section on page 2–12 for more 
information on these two variables.

– Account Information — The user name, group, and password (if you want to run 
the report as a user other than the AdminServer).

– Working Directory — The OpenEdge Management working directory (if you do 
not want to use the default working directory).

– 4GL Client Parameters — Any additional ABL client startup parameters.

– Generate debug log file — Indicates whether OpenEdge Management will create a 
trace file when it executes the report instance. Select the check box if you want to 
create debug log files; otherwise, leave the check box cleared. Creating a debug log 
file allows you to examine the report’s environment variables. When you are viewing 
the debug log file, you see that lines beginning with env show the names and values 
of applicable environment variables, as shown:

For a detailed explanation about environment variables, see the chapter on jobs in the 
OpenEdge Management: Resource Monitoring Guide.
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Creating a report instance

The specific steps you follow to create a report instance vary depending on the report’s menu 
group.

To create a report instance:

1. From the Create Report page, click the type of report you want to create. The Report 
Edit page for that report type appears.

2. Complete the top section of the Report Edit page, as described in the “Report Edit page” 
section on page 1–5. Note that certain reports contain unique fields. The following 
information will help you complete the unique fields:

• AppServer Application Profile and WebSpeed Application Profile reports:

Field Explanation

Resources The resource whose activity you want in the 
report. Click the right arrow to move a 
highlighted resource from the Available 
column to the Selected column. Click the left 
arrow to move a highlighted resource from the 
Selected field to the Available field. Click the 
up and down arrows to change the order in 
which the resources will appear in the report 
output.

Procedure filter To run a procedure filter, choose Literal, 
Begins With, or Matches and enter the 
applicable text in the field. Use the procedure 
filter to return data about when the broker ran 
a procedure. When the report instance runs, 
OpenEdge Management will search the 
OE_ActBrk table in the OpenEdge 
Management Trend Database for the text 
entered. 

Literal To use the Literal filter, type the exact text you 
want to find. For example, inventory.p. 

Begins with To use the Begins with filter, type the 
beginning of the procedure name. For 
example, in, inv, or inven.
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• AppServer Performance and WebSpeed Performance reports:

Matches To use the Matches filter, type the character 
expression that you want to match (such as 
.nventory or inven*). 

Note: The expression can contain wildcard 
characters. A period (.) indicates that any 
single character is acceptable in that position 
and an asterisk (*) indicates that any group of 
characters is acceptable. To use a literal period 
or asterisk in the expression, precede the 
period or asterisk by a tilde (~). 

You can also use the OR symbol or a vertical 
line ( | ) in the Matches field to indicate a 
search for one procedure or another procedure. 
For example, the expression
inventory.p | onorder.p indicates a search for 
either of these two procedures. The search 
concludes when at least one of them is found.

Note: You can identify multiple files using 
this approach. For example, 
inventory.p | onorder.p | bckorder.p. 

Sort order The criteria by which the returned procedure 
data is sorted and whether the data is sorted in 
descending or ascending order.

Field Explanation

Field Explanation

Resources The resource whose activity you want in the report.
Click the right arrow to move a highlighted resource 
from the Available column to the Selected column. 
Click the left arrow to move a highlighted resource 
from the Selected column to the Available column. 
Click the up and down arrows to change the order in 
which the resources will appear in the report output.

Data to display The desired broker activity on which to report: Client, 
Broker, and/or Server. 

Click the left arrow to move highlighted text from the 
Available to the Selected column. Click the right 
arrow to move highlighted text from the Selected to 
the Available column. 

Click the up and down arrows to change the order in 
which the activity data will appear in the report output.
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• Resource Alert Detail, Resource Status Detail, CPU Summary, Network Activity, 
System Disk Device Activity, System Memory Summary, and all Database menu 
group reports, as shown in the following table:

3. Complete the middle section of the Report Edit page, described in the “Report Edit page” 
section on page 1–5. Note that the time interval indicated by the Report on check box 
changes based on the report format chosen, as shown in the following table: 

4. Complete the bottom section of the Report Edit page, as described in the “Report Edit 
page” section on page 1–5.

5. Click Save. The name of your report instance appears, along with a summary of the report 
definition, in the list frame under Defined Reports.

After you create your report instance, you can:

• Click Edit to make changes in the report specifics. When you finish the edits, click 
Save.

• Click Copy to make a copy of the report specifics, perhaps to use for another report. 
Type a new name for the report instance, and click Save.

• Click Delete to remove the report instance. Click OK to delete the report instance.

You can run the report now or schedule it to run at a later time. See the “Running reports” 
section on page 3–10 for more details. 

Field Explanation

Resources The resource whose activity you want in the report.

This report 
format

With Report on option 
selected Displays the data

Hourly 15-minute intervals. Hourly, in four 15- minute 
intervals.

Daily Hourly. Daily in hourly increments.

Weekly Daily. Weekly in daily increments.

Monthly Weekly. Monthly in weekly 
increments.
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2
Historical Reports

Historical reports are created from information in the OpenEdge Management Trend Database. 
This chapter describes historical reports and how to create them, as outlined in the following 
sections:

• Overview of historical reports

• Historical report descriptions

• Customizing graphical output



Historical Reports
Overview of historical reports

Historical reports are created using data from the OpenEdge Management Trend Database.

To see available historical report templates, click Create Report from the OpenEdge 
Management Reports home page. The Create Report page appears.

Working with report templates

You can modify or delete any of the existing OpenEdge Management templates, or you can 
create your own templates. All report templates, regardless of whether they are provided with 
OpenEdge Management or created, appear in this list of report templates. If you add, delete, or 
rename a report template, that change is reflected on the Create Report page.

When you create a report template, you provide the template’s name, menu group (choose from 
the existing groups or create your own), and a brief report description that appears on the Create 
Report page. See the “Creating a custom report template” section on page 4–2 for detailed 
instructions on creating a report template.

Each of the report templates provided with OpenEdge Management defines reports based on 
one resource (with the exception of the AppServer and WebSpeed reports, which can report on 
multiple resources). When you modify the OpenEdge Management-provided report templates 
or create your own templates, you can choose to generate a report based on multiple resources 
or resources of different types (database and system CPU in one report, for example).

You can modify or remove any of the individual templates you see listed on the Create Report 
page. This flexibility allows you to set up an OpenEdge Management Reports page that 
includes only those reports relevant to your business needs. 

To delete a report template:

1. Expand the Report Templates category in the report list frame.

2. Click the report template name. The Report Template Summary page appears.

3. Click Delete. The template no longer appears on the Create Report page or in the list 
frame’s list of templates.
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Historical report descriptions

When you click the Create Report link on the OpenEdge Management Reports home page, 
the Create Report page appears with a list of report templates divided into the following menu 
groups:

• AppServer reports

• Database reports

• General reports

• System reports

• WebSpeed reports

Any report templates or menu groups you create will also show on the Create Report page.

Table 2–1 lists and describes each OpenEdge Management-provided report.

Table 2–1: OpenEdge Management-provided reports (1 of 9)

Report name Template name Description

AppServer 
Application Profile

appServerProfile Provides information on procedures run 
by the broker, including how many 
times the procedure ran, the average and 
maximum durations of each request, the 
number of successful requests, the 
number of errors, and the number of 
times each request quit and was stopped. 
The AppServer Application Profile 
report retrieves its data from the 
OE_ActASProc, OE_ActBrk, 
OE_ActSrv, and OE_APPService tables 
in the OpenEdge Management Trend 
Database. 
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AppServer 
Performance

appServerPerformance Provides performance information on 
broker, client, and server activity. 
Broker activity information returned 
includes number of complete requests, 
number of queued requests, percentage 
of queued requests, average and 
maximum request duration, average and 
maximum CPU use, and average and 
maximum memory use. Client activity 
information returned includes average 
and maximum number of active clients, 
and average and maximum number of 
client requests. Server activity 
information returned includes average 
and maximum CPU pool use, average 
and maximum memory pool use, 
average and maximum number of busy 
servers, average and maximum number 
of running servers, and average and 
maximum number of locked servers. 
The AppServer Performance report 
retrieves its data from the OE_ActBrk, 
OE_ActSrv, OE_APPService, and 
Sys_Process tables in the OpenEdge 
Management Trend Database. 

Database 
After-imaging

dbAfterImage Provides performance details for 
after-imaging, including read and write 
activity, full and partial buffer activity, 
and AIW write status. The Database 
After-imaging report retrieves its data 
from the Db_ActLog in the OpenEdge 
Management Trend Database. 

Database Area Status dbAreaStatus Provides trend status for each area 
within a database. Included in this report 
is information about total blocks, the 
high water mark, free blocks, available 
space (in blocks), and available space as 
a percentage of area. The Database Area 
Status report retrieves its data from the 
DB_AreaStatus table in the OpenEdge 
Management Trend Database.

Table 2–1: OpenEdge Management-provided reports (2 of 9)

Report name Template name Description
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Database 
Before-imaging

dbBeforeImage Provides performance details for 
before-imaging, including read and 
write activity; wait activity; full, partial, 
and empty buffer activity; and BIW 
statistics. This report also helps you 
determine the health of your BI 
subsystem by indicating increases in the 
amount of BI writes (which can indicate 
the growth of an application or 
questionable application design). The 
Database Before-imaging report 
retrieves its data from the Db_ActLog 
and Db_ActIOType tables in the 
OpenEdge Management Trend 
Database.

Database Buffer I/O dbMemory Provides details about memory buffer 
usages for all buffers (database, BI, and 
AI). The information provided in the 
Database Buffer I/O report helps you 
determine the proper use of OpenEdge 
memory on your machine. This report 
retrieves its data from the Db_ActBuf 
and Db_ActLog tables in the OpenEdge 
Management Trend Database. 

Database 
Checkpointing

dbCheckpoint Provides performance details for 
checkpoints. The Database 
Checkpointing report retrieves its data 
from the Db_Checkpoint table in the 
OpenEdge Management Trend 
Database. 

Database Details dbDetail Provides information on all database 
tables and includes fields from almost 
every table, depending on relevance. 
Use this report to gather 
cross-functional information and to 
understand the relationship among 
different aspects of an OpenEdge 
database. The Database Details report 
retrieves information from the following 
OpenEdge Management Trend 
Database tables: Db_ActBuf, 
Db_ActRec, Db_ActLog, 
Db_ActAPW, Db_ActIdx, 
Db_ActLock, Db_ActSum, and 
Db_ActIOType.

Table 2–1: OpenEdge Management-provided reports (3 of 9)

Report name Template name Description
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Database Disk 
Information

dbDisk Provides performance details for 
database reads and writes to disk, 
including database read and write 
activity, BI file, AI file, and index reads 
and writes. This report helps you track 
the growth of your database and predict 
when you need more throughput. The 
Database Disk Information report 
retrieves its data from the Db_ActSum, 
Db_ActAPW, and Db_ActIOType 
tables in the OpenEdge Management 
Trend Database. 

Database Index 
Analysis

dbIDXAnalysis Provides analysis of index information 
gathered from the execution of the 
database analysis job. Information 
provided in this report includes the 
maximum, minimum, and average of 
the number of blocks in the index, the 
number of bytes in the index, utilization 
percentage of the block space, and the 
number of index levels in the index. The 
Database Index Analysis report 
retrieves its information from the 
Db_IdxAnalysis table.

Note: In order for the Database Index 
Analysis report to display data, the 
Database Analysis job must first be run 
against the desired database. For more 
information on the Database Analysis 
job, see the OpenEdge Management: 
Database Management Guide.

Database Index 
Usage

dbIndexStat Provides performance details for each 
index in the schema, including the 
number of updates, creates, deletes, and 
blocks returned to the free chain. By 
showing which of your indexes are most 
active, this report helps you determine 
the structure of your database areas and 
where to place indexes. Combining the 
information presented in this report with 
that presented in the Database Table 
Usage report gives you a complete 
picture of database activity. The 
Database Index Utilization report 
retrieves its data from the Db_IndexStat 
table in the OpenEdge Management 
Trend Database. 

Note: OpenEdge Management reports 
on a default of 50 tables. Use the startup 
parameter -idxrangesize to increase 
this number, if necessary. This 
parameter must be set on the production 
database when it is started.

Table 2–1: OpenEdge Management-provided reports (4 of 9)

Report name Template name Description
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Database Locking dbLocks Provides performance details for record 
locking, based on the categories of 
requests, finds, locks, and waits. Each of 
the four categories contains information 
about exclusive, record, share, and 
upgrade locks. The Database Locking 
report retrieves its data from the 
Db_ActLock table in the OpenEdge 
Management Trend Database. 

Database Record 
Information

dbRecord Provides performance details for record 
locking, including information on 
increased record update activity, 
increased fragment activity, and 
increased record deletion. This report 
groups information into three 
categories: record, fragment, and bytes. 
Each category contains read, update, 
create, and delete fields. The Database 
Record Information report retrieves its 
data from the Db_ActRec table in the 
OpenEdge Management Trend 
Database. 

Database Server 
Activity

dbServer Provides detailed information about 
client activity on servers, including I/O 
for the server in bytes, records, and 
blocks. This report helps you assess the 
performance of your servers by showing 
how balanced or unbalanced the server 
activity is. The Database Server Activity 
report retrieves its information from the 
Db_ActServer table in the OpenEdge 
Management Trend Database.

Database Summary dbSummary Provides a summary of performance 
information for several subsections of a 
database, including logical and physical 
I/O, buffer activity, BI file activity, AI 
file activity, page writer activity, index 
I/O, table I/O, and record activity. The 
Database Summary report retrieves its 
data from the following OpenEdge 
Management Trend Database tables: 
Db_ActBuf, Db_ActSum, Db_ActRec, 
Db_ActLog, Db_ActAPW, Db_ActIdx, 
and Db_ActIOType.

Table 2–1: OpenEdge Management-provided reports (5 of 9)

Report name Template name Description
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Database Table 
Analysis

dbTabAnalysis Provides analysis of table information 
gathered from the execution of the 
database analysis job. This report 
includes the maximum, minimum, and 
average for the record counts, the 
number of bytes in the table, the number 
of record fragments in the table, and the 
scatter factor. The Database Table 
Analysis report retrieves its data from 
the Db_TabAnalysis table.

Note: In order for the Database Table 
Analysis report to display data, the 
Database Analysis job must first be run 
against the desired database. For more 
information on the Database Analysis 
job, see the OpenEdge Management: 
Database Management Guide.

Database Table 
Usage

dbTableStat Provides performance details for each 
table in the schema, including 
information related to the number of 
table updates, creates, and deletes. This 
report identifies which tables are the 
most active, allowing you to better 
structure your database areas by moving 
tables. The Database Table Utilization 
report retrieves its data from the 
Db_TableStat table in the OpenEdge 
Management Trend Database. 

Note: OpenEdge Management reports 
on a default of 50 tables. Use the startup 
parameter -tablerangesize to increase 
this number, if necessary. This 
parameter must be set on the production 
database when it is started.

Resource Alert Detail alertIndividual Provides summary and detail 
information for alerts specific to a 
resource, including counts of the 
different types of alerts that have 
occurred, details of all severe alerts, and 
data entered when the alert was cleared. 
The Resource Alert Detail report 
retrieves its data from the 
Cf_Alert_Detail table in the OpenEdge 
Management Trend Database.

Resource Alert 
Summary

alertGeneral Provides summary information about a 
site’s alerts, including information 
sorted by the resource name. This report 
shows which of a site’s resources cause 
the most problems. The Resource Alert 
Summary report retrieves its data from 
the Cf_Alert_Detail table in the 
OpenEdge Management Trend 
Database.

Table 2–1: OpenEdge Management-provided reports (6 of 9)

Report name Template name Description
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Resource Status 
Detail

statusDetail Provides a detail of status states for a 
resource. This report provides 
information that includes a category for 
each status change reported in the time 
frame chosen. Also, there are specific 
details for each status change within the 
database. The Resource Status Detail 
report retrieves its information from the 
Cf_Status table.

Resource Status 
Summary

statusSummary Provides a summary of status states for 
all resources. This report provides 
information that includes a category for 
each status reported in the time frame 
chosen. The Resource Status Summary 
report retrieves its data from the 
Cf_Status table.

CPU Summary systemCPU Provides a summary of the defined CPU 
resource’s performance. This report 
helps you track how well the CPU 
works, the different areas it works in, 
and how often it works in each area. Use 
the information from this report to 
identify growth in CPU usage over time. 
The CPU Summary report retrieves its 
data from the Sys_CPU table in the 
OpenEdge Management Trend 
Database. 

Note: If run for a multi-CPU system, 
this report returns information based on 
all the CPUs together. For further 
information on individual CPUs, refer to 
the appropriate vendor’s information.

File Summary fileSummary Provides size information about the 
defined file monitor. This report shows 
the average of the file size over the 
period being reported. Use this report to 
check the size of ASCII-based text files. 
This report does not typically deal with 
variable-length extents. The File Size 
Summary report retrieves its 
information from the Sys_FileSize table 
in the OpenEdge Management Trend 
Database. 

Network Activity network Provides status summaries for the 
defined network resource, including the 
count of statuses received during the 
report period as well as the average 
response time of tests. Use the 
information in this report to monitor and 
flag potential network bottlenecks.

Table 2–1: OpenEdge Management-provided reports (7 of 9)

Report name Template name Description
2–9



Historical Reports
System Disk Device 
Activity

systemDisk Provides performance information for 
defined disk devices, including the 
relationship between disk reads and 
writes and the average queue length of 
disk activity. Use this report to identify 
disk bottlenecks and a decline in disk 
performance. The System Disk Device 
Activity report retrieves its data from 
the Sys_Dev table in the OpenEdge 
Management Trend Database.

System Filesystem 
Usage

systemFileSystem Provides usage information for defined 
local or remote file systems, including 
how fast disk space grows from all 
software (including OpenEdge). Use 
this report to debug actual or potential 
file space problems where OpenEdge 
temporary files reside. The System 
Filesystem Usage report retrieves its 
data from the Sys_Filesys table in the 
OpenEdge Management Trend 
Database. 

System Memory 
Summary

systemMemory Provides a summary of the defined 
memory resource’s performance. By 
detailing how much memory is used and 
how much is available, this report helps 
identify growth in memory 
consumption. Combining the 
information in this report with that of 
the Database Buffer I/O report provides 
views of memory from the standpoint of 
both the system and OpenEdge. The 
System Memory Summary report 
retrieves this information from the 
Sys_Mem table in the OpenEdge 
Management Trend Database.

WebSpeed 
Application Profile

webSpeedProfile Provides information on procedures run 
by the broker, including how many 
times the procedure ran, the average and 
maximum durations of each request, the 
number of successful requests, the 
number of errors, and the number of 
times each request stopped. The 
WebSpeed Application Profile report 
retrieves its data from the 
OE_ActWSProc, OE_ActBrk, 
OE_ActSrv, and OE_APPService tables 
in the OpenEdge Management Trend 
Database. 

Table 2–1: OpenEdge Management-provided reports (8 of 9)

Report name Template name Description
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For more information about OpenEdge Management Trend Database tables, see the OpenEdge 
Management: Trend Database Guide and Reference.

Customizing graphical output

Each historical report is designed to display data in both graphical and tabular formats. You can 
customize the data displayed in the HTML graph report output. To do so, you must set the 
proper environment variable and identify the specific report fields or column headings that you 
want to include in the graph output. 

See the “Graphical output environment variables” section on page 2–12 for more information 
about the two environment variables that affect graphical output. See the “Report output field 
and column headings” section on page 2–15 for the field and column headings.

WebSpeed 
Performance

webSpeedPerformance Provides performance information on 
broker, client, and agent activity. Broker 
activity information returned includes 
number of complete requests, number of 
queued requests, percentage of queued 
requests, average and maximum request 
duration, average and maximum CPU 
use, and average and maximum memory 
use. Client activity information returned 
includes average and maximum number 
of active clients and average and 
maximum number of client requests. 
Server activity information returned 
includes average and maximum CPU 
pool use, average and maximum 
memory pool use, average and 
maximum number of busy servers, 
average and maximum number of 
running servers, and average and 
maximum number of locked servers. 
The WebSpeed Performance report 
retrieves its data from the OE_ActBrk, 
OE_ActSrv, OE_APPService, and 
Sys_Process tables in the OpenEdge 
Management Trend Database.

Table 2–1: OpenEdge Management-provided reports (9 of 9)

Report name Template name Description
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Graphical output environment variables

There are two environment variables that control how graphs display in HTML report output:

• GRAPH1COLUMNS — For use with report output associated with either a single 
resource or multiple resources. For example:

– For instances reporting on single resources, GRAPH1COLUMNS controls the 
number of columns displayed in the graph. For example, most historical reports are 
designed to display graphical data in HTML output associated with report-related 
default fields. However, by adding the variable GRAPH1COLUMNS followed by 
other fields associated with a report, you can customize the graphic report output. See 
the “Single resource output” section on page 2–12 for an example.

– For instances reporting on multiple resources, GRAPH1COLUMNS controls the 
number of graphs displayed. The output will contain one graph for each output 
category you indicate. Always enter the names of the output categories in quotes.

• fathomResourcesPerGraph — For use with report instances that report on multiple 
resources. This variable controls the number of resources displayed in each graph. The 
default number of resources displayed is five.

Note: Only AppServer and WebSpeed reports allow you to report on multiple resources.

Single resource output

Figure 2–1 shows an example of the type of graph that displays when you run the CPU 
Summary report without GRAPH1COLUMNS defined. In instances when you do not choose 
to define environment variables in the Environment field on the Create Report page, 
OpenEdge Management creates a report graph using the values associated with a report type’s 
default fields. 
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The graph report output example in Figure 2–1 uses the values associated with the CPU 
Summary report’s default fields.

Figure 2–1: CPU Summary output

In contrast, the following code entered in the Environment field on the Create Report page 
shows how you can customize the graph output of the report by defining a field: 

When the CPU Summary report is run with this code, the data associated with the specified field 
appears. Figure 2–2 shows this customized output. 

Figure 2–2: Customized graph output for CPU Summary

GRAPH1COLUMNS=CPU_Idle
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See the “Report output field and column headings” section on page 2–15 for a complete list of 
the column and field headings available for each report template.

Multiple resources output

Figure 2–3 shows an example of the type of graph that displays when you run the AppServer 
Application Profile report without the GRAPH1COLUMNS or the fathomResourcesPerGraph 
defined. In instances when you do not choose to define environment variables in the 
Environment field in the Create Report page, OpenEdge Management creates a report graph 
using the values associated with a report type’s default fields.

The graph report output example in Figure 2–3 uses the values associated with the AppServer 
Application Profile report’s default fields.

Figure 2–3: AppServer Application Profile output

In contrast, the following information entered in the Environment field on the Create Reports 
page shows how you can customize the graph output of the report by defining:

• Column headings for GRAPH1COLUMNS. 

• Number of resources to display per graph for fathomResourcesPerGraph.

When the AppServer Application Profile report is run with the following code, only the column 
heading-related data, with the specified number of resources per graph, appears: 

GRAPH1COLUMNS=”Run Count,Request Duration (avg),Return Code Success”

fathomResourcesPerGraph=”7”
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Figure 2–4, Figure 2–5, and Figure 2–6 show this customized output.

Figure 2–4: Request duration graph

Figure 2–5: Return code success graph

Figure 2–6: Run count graph

Report output field and column headings

This section identifies the fields or column headings associated with each historical report 
template. 

Note: Fields and column headings in this section that are identified with an asterisk (*) are 
also the OpenEdge Management-supplied defaults associated with each report type.
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AppServer Application Profile

Table 2–2 identifies the AppServer Application Profile column headings.

AppServer Performance

Table 2–3, Table 2–4, and Table 2–5 identify the column headings for an AppServer 
Performance graphical report.

Table 2–2: AppServer Application Profile column headings

Run Count* Average Request Duration 
(ms)

Maximum Request Duration 
(ms)

Return Code Success Return Code Error Return Code Quit

Return Code Stop Sample Count –

Table 2–3: AppServer Client Activity column headings

Average Active Clients* Maximum Active Clients Client Requests

Average Client Requests Maximum Client Requests Sample Count

Table 2–4: AppServer Broker Activity column headings

Requests Completed Requests Queued Requests Queued %

*Average Request Duration 
(ms)

Maximum Request Duration 
(ms)

Average CPU Usage %

Maximum CPU Usage % Average Memory Usage (k) Maximum Memory Usage 
(k)

Sample Count – –

Table 2–5: AppServer Activity column headings

Average Pool CPU Usage % Maximum Pool CPU
Usage %

Average Pool Memory 
Usage % (k)

Maximum Pool Memory 
Usage (k)

*Average Busy Server 
Count

Maximum Busy Server 
Count

Average Busy Server Time 
(ms)

Average Locked Server 
Count

Maximum Locked Server 
Count

Average Locked Server 
Time (ms)

Sample Count –
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Database After-imaging

Table 2–6 identifies the column headings for a Database After-Imaging graphical report.

Database Area Status

Table 2–7 identifies the column headings for a Database Area Status graphical report.

Database Before-imaging

Table 2–8 identifies the fields for a Database Before-Imaging graphical report.

Database Checkpointing

Table 2–9 identifies the column headings for a Database Checkpointing graphical report.

Table 2–6: Database After-Imaging column headings

ActLog_AIBBufWaits ActLog_AIByteWrites ActLog_AINoBufAvail

ActLog_AIPartialWrites ActLog_AIRecWrites ActLog_AITotWrites*

ActLog_AIWWrites* – –

Table 2–7: Database Area Status column headings

Sample Count Total Blocks Hi Water Mark*

Free Blocks RM Blocks Blocks Available*

Pct. Blocks Available – –

Table 2–8: Database Before-Imaging fields 

ActLog_BITotReads ActLog_BITotWrites* ActLog_BIWWrites*

ActSum_BIReads ActSum_BIWrites ActLog_BIBBufWaits

ActLog_BIByteReads ActLog_BIByteWrites ActLog_BIEBufWaits

ActLog_BIPartialWrites ActLog_BIRecReads ActLog_BIRecWrites

Table 2–9: Database Checkpointing column headings

Sample Count Checkpoint Length* Buffer Scanned

Checkpoint Queue APW Queue Buffers Flushed*
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Database Details

Table 2–10 identifies the fields for a Database Details graphical report.

Table 2–10: Database Details fields (1 of 2)

ActBuf_Flushed ActBuf_LogicReads* ActBuf_LogicWrites*

ActSum_DbReads ActSum_DbWrites ActRec_RecRead

ActLog_BITotWrites ActLog_BIWWrites ActAPW_APWEnq

ActIOType_IdxReads ActIOType_IdxWrites ActAPW_APWQWrites

ActAPW_BufsCkpt ActAPW_BufsScanned ActAPW_CkptQWrites

ActAPW_Ckpts ActAPW_DBWrites ActAPW_Marked

ActAPW_ScanCycles ActAPW_ScanWrites ActAPW_TotDBWrites

ActBuf_Deferred ActBuf_OSReads ActBuf_OSWrites

ActIdx_Create ActIdx_Delete ActIdx_Find

ActIdx_Free ActIdx_Remove ActIdx_Splits

ActLock_CancelReq ActLock_Downgrade ActLock_ExclFind

ActLock_ExclLock ActLock_ExclReq ActLock_ExclWait

ActLock_RecGetLock ActLock_RecGetReq ActLock_RecGetWait

ActLock_ShrFind ActLock_ShrLock ActLock_ShrReq

ActLock_ShrWait ActLock_UpgLock ActLock_UpgReq

ActLock_UpgWait ActRec_ByteCreate ActRec_ByteDel

ActRec_ByteRead ActRec_ByteUpd ActRec_FragCreate

ActRec_FragDel ActRec_FragRead ActRec_FragUpd

ActRec_RecCreate ActRec_RecDel ActRec_RecLock

ActRec_RecUpd ActRec_RecWait ActSum_AllocNewRm

ActSum_BytesAlloc ActSum_Examined ActSum_FromFree

ActSum_FromRm ActSum_Removed ActSum_RetFree

ActSum_TakeFree ActSum_AiWrites ActSum_BiReads

ActSum_Commits ActSum_DBAccesses ActSum_DbExtend

ActSum_Undos ActLog_AIBBufWaits ActLog_AIByteWrites

ActLog_AINoBufAvail ActLog_AiPartialWrites ActLog_AIRecWrites

ActLog_AITotWrites ActLog_AIWWrites ActLog_BIBufWaits

ActLog_BIByteReads ActLog_BIByteWrites ActLog_BIEBufWaits
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Database Disk Information

Table 2–11 identifies the fields for a Database Disk Information graphical report.

Database Index Analysis

Table 2–12 identifies the column headings for a Database Index Analysis graphical report.

Database Index Usage

Table 2–13 identifies the column headings for a Database Index Usage graphical report.

ActLog_BIPartialWrites ActLog_BIRecReads ActLog_BIRecWrites

ActLog_BITotReads ActIOType_AiReads ActIOType_AiWrites

ActIOType_BiReads ActIOType_BiWrites ActIOType_DataReads

ActIOType_DataWrites – –

Table 2–11: Database Disk Information fields 

ActSum_DbReads ActSum_DbWrites ActAPW_DBWrites*

ActAPW_TotDBWrites* ActSum_DbAccesses ActSum_DbExtend

ActIOType_AiReads ActIOType_AiWrites ActIOType_BiReads

ActIOType_BiWrites ActIOType_DataReads ActIOType_DataWrites

ActIOType_IdxReads ActIOType_IdxWrites –

Table 2–12: Database Index Analysis column headings 

Sample Count Max Block Count Min Block Count

Avg Block Count Max Byte Count Min Byte Count

Avg Byte Count Max Util Percent Min Util Percent

Avg Util Percent* Max Level Count Min Level Count

Avg Level Count – –

Table 2–13: Database Index Utilization column headings 

Index Reads* Index Splits Index Creates

Index Deletes – –

Table 2–10: Database Details fields (2 of 2)
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Database Locking

Table 2–14 identifies the fields for a Database Locking graphical report.

Database Buffer I/O

Table 2–15 identifies the fields for a Database Buffer I/O graphical report.

Database Record Information

Table 2–16 identifies the fields for a Database Record Information graphical report.

Table 2–14: Database Locking fields 

ActLock_CancelReq ActLock_Downgrade ActLock_ExclFind

ActLock_ExclLock ActLock_ExclReq ActLock_ExclWait*

ActLock_RecGetLock ActLock_RecGetReq ActLock_RecGetWait*

ActLock_ShrFind ActLock_ShrLock ActLock_ShrReq

ActLock_ShrWait* ActLock_UpgLock ActLock_UpgReq

ActLock_UpgWait* – –

Table 2–15: Database Memory Usage fields 

ActBuf_Flushed ActBuf_LogicReads* ActBuf_LogicWrites

ActBuf_Deferred ActBuf_OSReads* ActLog_AIBBufWaits

ActLog_AINoBufAvail ActLog_AIPartialWrites ActLog_BIBBufWaits

ActLog_BIEBPartialWaits ActLog_BIPartialWrites –

Table 2–16: Database Record Information fields

ActRec_RecRead ActRec_RecCreate* ActRec_RecDel*

ActRec_ByteRead ActRec_ByteUpd ActRec_FragCreate

ActRec_FragDel ActRec_FragRead ActRec_FragUpd

ActRec_RecCreate ActRec_RecDel ActRec_RecLock*

ActRec_RecUpd* ActRec_RecWait ActRec_ByteCreate

ActRec_ByteDel – –
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Database Server Activity

Table 2–17 identifies the column headings for a Database Server Activity graphical report.

Database Summary

Table 2–18 identifies the fields for a Database Summary graphical report.

Database Table Analysis

Table 2–19 identifies the column headings for a Database Table Analysis graphical report.

Table 2–17: Database Server Activity column headings

Messages Received Messages Sent Bytes Received

Bytes Sent Records Received* Records Sent*

Min Users Max Users Avg Users

Table 2–18: Database Summary fields

ActBuf_Flushed ActBuf_LogicReads* ActBuf_LogicWrites*

ActSum_DbReads ActSum_DbWrites ActRec_RecRead

ActLog_BITotWrites ActLog_BIWWrites ActAPW_BufsCkpt

ActBuf_OSReads ActBuf_OSWrites ActIdx_Create

ActIdx_Delete ActIdx_Find ActIdx_Free

AdxIdx_Remove ActIdx_Splits ActSum_Commits

ActSum_DbAccesses* ActSum_DbExtend ActIOType_DataReads

ActIOType_IdxReads ActIOType_IdxWrites –

Table 2–19: Database Table Analysis column headings

Sample Count Max Record Count Min Record Count

Ave Record Count* Max # of Bytes Min # of Bytes

Ave # of Bytes Max # of Fragments Min # of Fragments

Ave # of Fragments Max Scatter Factor Min Scatter Factor

Ave Scatter Factor – –
2–21



Historical Reports
Database Table Usage

Table 2–20 identifies the column headings for a Database Table Usage graphical report.

CPU Summary

Table 2–21 identifies the fields for a CPU Summary graphical report.

File Summary

Table 2–22 identifies the column headings for a File Summary graphical report.

Network Activity

Table 2–23 identifies the column headings for a Network Activity graphical report.

System Disk Device Activity

Table 2–24 identifies the column headings for a System Disk Device Activity graphical report.

Table 2–20: Database Table Usage column headings

Record Reads* Record Updates* Record Creates*

Record Deletes* – –

Table 2–21: CPU Summary fields

CPU_User* CPU_System* CPU_Wait*

CPU_Idle – –

Table 2–22: File Summary column headings

Sample Count Average File Size (k)* Minimum Size (k)

Maximum Size (k) – –

Table 2–23: Network Activity column headings

Sample Count Avg. Response* –

Table 2–24: System Disk Device Activity column headings

Sample Count Pct Busy* Avg Queue

Avg Wait Avg Serve Minimum Busy

Maximum Busy – –
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System Filesystem Usage

Table 2–25 identifies the column headings for a System Filesystem Usage graphical report.

System Memory Summary

Table 2–26 identifies the column headings for a System Memory Summary graphical report.

WebSpeed Application Profile

Table 2–27 identifies the column headings for a WebSpeed Application Profile graphical 
report.

WebSpeed Performance

Table 2–28, Table 2–29, and Table 2–30 identify the column headings for a WebSpeed 
Performance graphical report.

Table 2–25: System Filesystem Usage column headings

Sample Count Capacity Pct Used*

Current Available Maximum Available Minimum Available

Table 2–26: System Memory Summary column headings

Max System Memory Min System Memory Max Virtual Memory

Min Virtual Memory Max Free System Memory Min Free System Memory

Max Free Virtual Memory Min Free Virtual Memory Pages In

Pages Out – –

Table 2–27: WebSpeed Application Profile column headings

Run Count* Average Request Duration 
(ms)

Maximum Request Duration 
(ms)

Sample Count – –

Table 2–28: WebSpeed Client Activity column headings

Average Active Clients* Maximum Active Clients Client Requests

Average Client Requests Maximum Client Requests Sample Count
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Table 2–29: WebSpeed Broker Activity column headings

Requests Completed Requests Queued Requests Queued %

*Average Request Duration 
(ms)

Maximum Request Duration 
(ms)

Average CPU Usage %

Maximum CPU Usage % Average Memory Usage (k) Maximum Memory Usage 
(k)

Sample Count – –

Table 2–30: WebSpeed Server Activity column headings

Average Pool CPU Usage % Maximum Pool CPU Usage % Average Pool Memory 
Usage (k)

Maximum Pool Memory 
Usage (k)

*Average Busy Server Count Maximum Busy Server 
Count

Average Busy Server Time 
(ms)

Average Locked Server Count Maximum Locked Server 
Count

Average Locked Server 
Time(ms)

Sample Count –
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3
Working with Report Instances

Once you create a report instance, you can run the report immediately or schedule it to run at a 
later time. You can also view information about all scheduled, completed, or running reports. 
This chapter contains the following sections:

• Scheduling reports to run

• Viewing report output

• Viewing report history

• Scheduled reports

• Completed reports

• Running reports



Working with Report Instances
Scheduling reports to run

A report instance will not run until you tell OpenEdge Management to run it immediately or you 
schedule it. 

To run a report immediately:

1. If the report’s Summary page is not displayed, choose the report from the Defined 
Reports section of the list frame. The Summary page appears.

2. From the Summary page, click Run Now. A message appears acknowledging your report 
request.

After you run the report, you can view the output by clicking View Last Output File. See the 
“Viewing report output” section on page 3–3 for more information.

To schedule a report to run at another time:

1. If the report’s Summary page is not displayed, choose the report from the Defined 
Reports section of the list frame. The Summary page appears.

2. From the Summary page, click Schedule. The Report Schedule page appears:

3. Choose a start date and time.
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4. Determine the repeat interval: One time, At startup, Weekly from date, Monthly from 
date, Every 5 minutes, Every 15 minutes, Every 30 minutes, Every 60 minutes, Daily, 
or Cron expression.

Use cron-based scheduling when you need a report to run at a specific time, such as 
according to a business period interval (on the last Friday of the month, or every ten 
minutes from 4 P.M. to 6 P.M. daily, for example).

You can include from one to five cron expressions (separated by semi-colons) in the Cron 
expression field in a job schedule. Once you click in the Cron Expression field, you can 
click Assist for help in choosing the month, day, date, etc., which will then be translated 
into cron expression format for you.

For more details about using cron expressions, click the Cron expression field Help 
button or see the chapter on jobs in the OpenEdge Management: Resource Monitoring 
Guide.

5. Select which days to include.

6. Select the Enabled check box (if it is not already selected). 

7. Click Save.

After the report’s scheduled run, you can view the output by clicking View Last Output File 
from the Summary page. 

Viewing report output

After you run a report, you can view:

• The last output file for the report.

• A list of output files for the report.

• The history of the report.

To view the last output file generated for a report:

1. If the report’s Summary page is not displayed, choose the report from the Defined 
Reports section of the list frame. The Summary page appears.

2. Click View Last Output File. The report opens.

3. Use the scroll bar to review the output, or choose File→ Print if you want a hard copy 
version.

The details that the report supplies depend on the type of report you are running. 
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Figure 3–1 shows the output from a Database Area Status report.

Figure 3–1: Sample Database Area Status report output

Note: Some reports include a category called Change Pct. If the difference between the first 
set of data and the last set of data is more than 20%, the change percentage is shown 
in the report. If the change is less than 20%, the column is empty.
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To see a list of all output files for a report:

1. If the report’s Summary page is not displayed, choose the report from the Defined 
Reports section of the list frame. The Summary page appears.

2. Click List of Report Output Files. The Completed Reports page appears with a list of 
the reports that have been created, as shown:

The following table describes the files that appear on the Completed Reports page:

The most recently created files appear first. 

Note: If a report is scheduled to run frequently, the list of output files can grow large.

Files with this 
extension Contain the report . . .

.err Errors.

.htm Output in HTML format.

.log Debugging information. OpenEdge Management creates a 
debug log file when you select the Generate debug log 
file check box on the Report Edit page.

.out Status.

.txt Output in text format.

.xml Output in xml format, with debugging information.
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3. Select the desired report file and click View. The display of report output depends on the 
report run and whether you chose to view the text or HTML file. For an example of HTML 
output, see Figure 3–1. The following is an example of text output:

To delete a report output file:

1. Navigate to the Completed Reports page.

2. Select the output file you want to delete. 

3. Click Delete.

Viewing report history 

Once a report instance has run, you can view summary information about it. OpenEdge 
Management displays the following information for each completed report instance:

• The report name.

• The start time (when the report began running).

• The end time (when the report finished running).

• The exit code.

A report’s exit code indicates whether or not the process succeeded. Typically, an exit code of 
zero indicates success, while a nonzero code indicates an error. For more information on 
nonzero exit codes, search the log file. If a report running in Windows returns a positive, 
nonzero code, use the net helpmsg command for information. 
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To view a report’s history:

1. If the report’s Summary page is not displayed, choose the report from the Defined 
Reports section of the list frame. The Summary page appears.

2. Click View Report History. The Report History page appears.

3. In the Report History query section, select the period of time.

4. Click Submit. The report’s history appears on the bottom of the Report History page:

Note: The previous steps show how to access the history of a single report. For the history of 
all reports run, click View Report History from the OpenEdge Management 
Reports page (shown in Figure 1–1). Continue from Step 3 in the previous procedure. 
The query returns results for any reports run during the date range.

To remove a report’s history, follow the previous steps. After submitting the query dates, click 
Purge Selection. Once you purge a selection, you can no longer access the report’s history for 
that time frame.
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Scheduled reports

Use the Scheduled Reports page to track all scheduled report instances.

To view a list of reports that are scheduled to run:

From the OpenEdge Management Reports home page, click View Scheduled Reports. The 
Scheduled Reports page appears:

Clicking a report name brings you to the report’s Summary page. 

If an expected report instance does not appear on the Scheduled Reports page, make sure the 
Enabled box is checked on that report’s Edit page. Only enabled reports appear in the 
Scheduled Reports list.
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Completed reports 

Use the Completed Reports page to track which reports have run.

To view reports that have completed running:

Click View Completed Reports from the OpenEdge Management Reports page. 

A list of reports already run appears:

Note that each report is listed under its corresponding resource type, report name, and 
occurrence.

To view a report, select it and click View.

To delete a report, select it and click Delete. Click OK to confirm the deletion.

Note: Deleting reports from the Report Viewer removes the report output file. It does not 
delete the report’s data from the OpenEdge Management Trend Database. 
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Running reports

The Running Reports page displays the following details about each report:

• The report name.

• The process ID.

• The start time (when the report began running).

• The command executed to run the report.

• Any parameters you defined for the command.

To view a list of reports that are currently running, click View Running Reports from the 
OpenEdge Management Reports home page. A list of reports appears:

Clicking a report name brings you to the report’s Summary page.
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4
Creating Custom Report Templates

Using OpenEdge Management, you can create your own report templates or modify any of the 
supplied templates. Once you edit a report template (or create your own), you need not re-enter 
the criteria each time you want to create a report instance.

This chapter explains how to work with custom report templates, as described in the following 
sections:

• Creating a custom report template

• Editing the report template

• Copying the report template

• Deleting the report template

• Importing and exporting report templates



Creating Custom Report Templates
Creating a custom report template

You specify each OpenEdge Management report template’s properties and characteristics on 
two pages. The first template page defines the properties that are related to the type of report. 
You cannot change these properties in the instances you create from the template. On the second 
page, you provide default values for the report instances. These values, such as the schedule, 
can be changed. 

To create a report template:

1. From the OpenEdge Management Reports home page, click Create Report Template. 
The first of two Report Template pages appears. This first page consists of a Template 
Properties box divided into four sections. 

The first two sections are shown below:

2. You must provide the following information:

a. In the Name field, enter the report template name. Note that the name must be unique 
among the report templates. Note also that spaces are not allowed in the name fields 
on this page.

b. In the Menu group field, enter the name of the new menu group, or choose an 
existing menu group in the Existing field. (When you choose an existing group, the 
name automatically appears in the Menu group field.) The menu group is the 
heading under which the report template name appears (for example, Database 
Reports). 

c. In the Menu entry field, enter the template name you want to appear on the Custom 
Create Trend Report page (for example, Database Monthly Report).

d. In the Menu description field, enter a brief description of the report template. This 
is the description that appears in the list of available report templates on the Create 
Custom Trend Report page under the name specified in Step c.
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3. Continue to the third section of the Template Properties box:

Under Source of eligible resources, choose one of the following:

• Resources currently defined on the system — Only those resources, such as 
databases, defined for a container. This is the default that all OpenEdge 
Management-provided report templates use, unless you modify the template and 
change it. 

• Local resources in the trend database — Information obtained from whatever is in 
the local trend database. This might include resources no longer on your machine; 
information can be gathered from historical records. 

Note: Use this option only if you are trending locally.

• All resources in the trend database — This includes local resources as well as 
resources that are not local but are trending to the trend database. The report instance 
will display choices such as the container name and the resource name. Selection lists 
for each site will be added to the page. 

4. Under Resource types, review the available types: Database, System CPU, System 
Memory, System Disk, System File system, Network, File, AppServer, and 
WebSpeed. 

Highlight a type, then click the right arrow to move it to the Selected column. To remove 
a type from the Selected column, highlight the type and then click the left arrow.

When creating a template for an AppServer or WebSpeed resource, indicate if the report 
should be a performance or profile report.

5. Under Limit how many resources can be included in the report, select how many 
database resources and how many total resources the report instance is allowed to select. 
You can choose up to three in each field. (Keep in mind that the All resources field 
includes databases.)
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6. Continue to the fourth section of the Template Properties box:

a. In the Progress 4GL program to run field, enter the path to the ABL (formerly 
known as Progress 4GL) program to run when this report is scheduled. 

When you create a report by using any one of the OpenEdge Management report 
templates, the particular ABL program that you use to run the report is provided in 
the <OpenEdgeManagement-install-dir>\src directory. When you create your 
own report template, you must provide the name of the ABL program to run. To run 
a program that you’ve written, copy the program into 
<OpenEdgeManagement-install-dir>\src and include the fully qualified path of 
your program in the Progress 4GL program to run field. 

For more information about writing programs in the ABL, see OpenEdge 
Development: Programming Interfaces.

b. In the Title of generated report field, enter the text that you want to use for the title 
in the report result.

c. In the Output file sub-directory field, enter the location where the generated report 
output file will be stored when the report is run. 

OpenEdge Management stores completed reports in a reports subdirectory in your 
working directory. You do not need to create this directory; OpenEdge Management 
creates it during the installation process. Within the reports subdirectory, there are 
subdirectories based on each Historical report type. Another set of subdirectories, 
based on the name of each report, is created within the report type subdirectories. 
OpenEdge Management names reports by their full path, followed by the year, 
month, day, hour, minute, and second of the report’s generation, as well as by the site 
ID and the resource name. 

The default directory for OpenEdge Management-provided reports is:

<OpenEdgeManagement-workdirectory>\reports\<resource-type>
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7. Click Save at the top of the Report Template page to save the report template properties.

The second of two Report Template pages (the Report Properties page) appears with 
the Name field filled:

8. You must provide the following information:

• Description — A description of the template.

• Output Formats — Select whether you want the report’s output in text, HTML, or 
both.

• Report Format — Select the format for your report: Hourly, Daily, Weekly, 
Monthly. To break the report display into additional columns, select the Report on 
check box. 

• Report period — Choose a previous number of days or specify a block of days by 
choosing the start date and end date. 
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• Time period — Choose either full day or a block of time.

• Display units — Choose the period of time, such as per second, per minute, per hour, 
per transaction, raw data, per record. 

• Environment — Enter any environment variables. Available environment variables 
depend on the type of report you are creating and your environment. For a list of 
environment variables available for the report, run the report with the Generate 
debug log file option on. The debug log file lists all environment variables and, if 
applicable, their values. Environment variables are proceeded by env in the log file.

For a detailed explanation about environment variables, see the chapter on jobs in the 
OpenEdge Management: Resource Monitoring Guide.

• User name — Enter your user name. Providing this information is optional; you can 
also run the report using another user’s name. If you do not supply a name, the report 
runs under the account given in the AdminServer.

• Password — Enter your password (optional; required only if you also enter a user 
name).

• 4GL client parameters — List any other client parameters you want to pass to the 
ABL program that produces the report output.

• Generate debug log file — Select the check box if you want to create a debug log 
file; otherwise, leave the check box cleared. Creating a debug log file allows you to 
examine the report’s environment variables. When viewing the debug log file, lines 
beginning with env show the names and values of applicable environment variables.

Note: See the “Report instances” section on page 1–4 for details about entering 
information into the Report Properties page.

9. Click Save. The Report Template Summary page appears.

You can now edit or copy the template’s characteristics, delete the template, or create a report 
instance to run based on the template.

Once you create a report instance from a report template, the two are no longer tied together. 
You can modify the characteristics of a report instance without affecting the template, and you 
can update the template without affecting the characteristics of a report instance you have 
already created.
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Editing the report template

Once you create a report template, you can edit it.

To edit a report template:

1. From the Report Summary page, click Edit. The first template page appears.

2. Make whatever edits you want and click Save. The second template page appears.

3. Make your edits and click Save. The Report Summary page appears, reflecting the 
changes you have made.

Copying the report template

You can copy the report template and use it as the basis for another template.

To copy a report template:

1. From the Report Summary page, click Copy. The first template page appears.

2. Enter a unique name and a unique menu entry in the fields provided.

3. Click Save.

Deleting the report template

After creating a report template, you may decide to delete it.

To delete a report template:

1. From the Report Summary page, click Delete. A message appears asking you to confirm 
that you want to delete the template.

2. Click OK to confirm the deletion.

Importing and exporting report templates

You can either import report templates into your own environment or export them to another 
environment.

For detailed information about importing and exporting templates, see the OpenEdge 
Management: Resource Monitoring Guide.
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5
Real-time Reports

Real-time reports receive their information directly from resources. Because these reports are 
real-time, the data they contain represents the state of your system at the time of the report’s 
generation. This chapter contains the following sections:

• Introduction

• System Information report

• System Activity report

• Open Alert Detail report

• Hotspot report

• Database Summary report

• Open Alert Summary report



Real-time Reports
Introduction

To access real-time reports, expand the Realtime Reports category of the Reports list frame, 
as shown in Figure 5–1.

Figure 5–1: Real-time reports

You can run the following real-time reports: 

• Database Summary report — Displays a summary report of all databases.

• Hotspot report — Displays a report of all resources with open alerts.

• Open Alert Detail report — Displays a detailed report of all open alerts.

• Open Alert Summary report — Displays a summary report of all open alerts.

• System Activity report — Displays system performance and resource utilization details 
identified by container.

• System Information report — Displays system and operating system information details 
identified by container.

The following sections describe the contents of each type of report.
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System Information report

The System Information report displays the information shown in Table 5–1.

System Activity report

The System Activity report displays the information shown in Table 5–2.

Table 5–1: System Information report details

Category Detail

Host information Name of the host machine.
IP address for the host machine.
Host’s system time.
Host’s system up-time.

Operating system Operating system name.
Operating system version.

OpenEdge 
Management

OpenEdge Management version number.
OpenEdge Management install directory.
OpenEdge Management work directory.
OpenEdge Management report directory.
OpenEdge Management up-time.

OpenEdge OpenEdge version.
OpenEdge install directory.

Java™ Java vendor.
Java version.
Java classpath.

Paths Library path.
System path.

Table 5–2: System Activity report details

Category Details

Host information Name of the host machine.
Operating system version.
IP address.
System up-time.
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Open Alert Detail report

The Open Alert Detail report displays the following alert statistics:

• OpenEdge Management up-time.

• Most recent alert.

• Worst-case severity.

• Number of open alerts.

• Number of unseen alerts.

• Number of open alerts from last hour.

• Number of open alerts from last 24 hours.

• Number of monitored resources.

• Number of resources with alerts.

• Percentage of resources with alerts.

• Number of internal alerts.

Hotspot report

The Hotspot report displays the following information for each resource that is a hot spot:

• Last date and time of the alert.

• Name of the alert.

• Severity of the alert.

• Count of the alert.

CPU utilization Percentage of CPU that is busy.
Percentage of CPU being used.
Percentage of CPU kernel being used.
Percentage of CPU wait I/O.

Memory utilization Total system memory use.
Total swap memory use.
Pages input.
Amount of system free/used.
Amount of swap free/used.
Pages output.

Table 5–2: System Activity report details

Category Details
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Database Summary report

The Database Summary report displays the following information:

• Overall database statistics, including:

– Total number of databases.

– Number of running databases.

– Number of databases licensed for monitoring.

– Number of databases with alerts.

– Percentage of databases with alerts.

• Statistics for each database are listed separately and include:

– Database location.

– Database status.

– Monitoring agent status.

– Polling status.

– Time in polling status.

– Number of alerts.

Open Alert Summary report

The Open Alert Summary report displays the following alert statistics:

• OpenEdge Management up-time.

• Date and time of most recent alert.

• Worst case severity.

• Number of open alerts.

• Number of unseen alerts.

• Number of open alerts from last hour.

• Number of open alerts from last 24 hours.

• Number of monitored resources.

• Number of resources with alerts.

• Percentage of resources with alerts.

• Number of internal alerts.
5–5



Real-time Reports
The Open Alert Summary report also lists the following for each open alert:

• Last date and time of the alert.

• Container in which the monitored resource resides.

• Monitored resource.

• Name of the alert.

• Severity of the alert.

• Count of the alert.
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6
OpenEdge Management Diagnostic 
Reports

You access OpenEdge Management Diagnostic reports through the list frame. These reports 
provide information to help both you and technical support debug OpenEdge Management 
problems. The following sections detail the diagnostic tools:

• Viewing OpenEdge Management log files

• OpenEdge Management Task Scheduler

• OpenEdge Management Work Scheduler



OpenEdge Management Diagnostic Reports
Viewing OpenEdge Management log files 

From the OpenEdge Management Reports list frame, you can view the AdminServer log file 
(admserv.log). 

To access the log file, expand the Diagnostic Reports category and click AdminServer Log 
File. The log file appears:

A summary box provides these details: size of log, lines in log, display start line, percentage of 
log at start line, and log file status.

You work with the file as follows:

• Click First to go to the beginning of the file.

• Click Prior to see the same number of entries preceding those you are currently viewing. 
For example, if you are viewing 20 entries and you click Prior, the preceding 20 entries 
appear.

• Click Next to see the same number of entries following those you are currently viewing. 
For example, if you are viewing 20 entries and you click Next, the following 20 entries 
appear.

• Click Last to see the final entries in the log file.

• Click Reload to refresh the log file. 
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• To go to a particular entry in the file, type the line number in the Go To field, and then 
click Go To.

• To specify how many entries you want to see at one time, type the number in the Show 
field. You can also specify how many entries can overlap in the Overlap field.

• Choose either Ascending or Descending to specify the sort order of the log file.

OpenEdge Management Task Scheduler

The Task Scheduler page is provided for OpenEdge Management diagnostic purposes. If you 
encounter problems with OpenEdge Management jobs or reports, Technical Support will use 
the information provided by the Task Scheduler when debugging. Figure 6–1 shows a sample 
Task Scheduler page.

Figure 6–1: Sample Task Scheduler page
6–3



OpenEdge Management Diagnostic Reports
Table 6–1 explains the contents that appear on the Task Scheduler page.

Note: If the defined tasks are not scheduled to run (that is, they do not have a schedule 
defined or their schedules are not enabled), only the Schedule table appears on the 
Task Scheduler page. 

OpenEdge Management uses the Quartz Enterprise Job Scheduler to run tasks. The Restart 
button allows you to stop and restart the Quartz Scheduler. Use the Restart button only when 
directed to do so by Technical Support.

Note: For more information about the Quartz Enterprise Job Scheduler, see 
https://www.quartz-scheduler.org.

To access the Task Scheduler, expand the Diagnostic Reports category and click Task 
Scheduler. The OpenEdge Management Task Scheduler Diagnostics page appears.

Table 6–1: Task Scheduler Diagnostics

Table Column heading Description

Schedule Internal name of the schedule.

Resource Owning job or report resource name.

Type Type of task (job or report).

State State of the task (disabled or scheduled).

Next Run Next scheduled run after the present time.

Run Count Number of times the scheduled task has run 
since OpenEdge Management started.

Triggers Name of any schedule triggers, if present. 
(Triggers contain the actual scheduling 
information).

Trigger Internal name of the trigger, if one is present.

Schedule Name of the owning schedule (this will match 
the names listed in the schedule table).

State State of the trigger: complete, default, error, 
none, normal, or paused.

Previous Run Time stamp of the trigger’s previous run.

Next Run Time the trigger is next scheduled to run.
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OpenEdge Management Work Scheduler

The Work Scheduler page is provided for OpenEdge Management diagnostic purposes. If you 
encounter problems with OpenEdge Management, Technical Support will use the information 
provided by the Work Scheduler when debugging. 

To access the Work Scheduler, expand the Diagnostic Reports category and click Work 
Scheduler. The OpenEdge Management Work Scheduler Diagnostics page appears:

For more detail about a work category, click the Thread Detail button below it.
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